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Where Should You Begin? 



 

 

12 steps to a great site with Web CEO  

What is the Web CEO Integrated Approach?  
 

Based on years of experience in developing websites, managing 
traffic, and coming up with the best practices in search engine 
optimization, we’ve designed the Web CEO Integrated Approach. 
It consists of twelve straightforward steps toward making your 
website stand out, draw traffic, and work for your business: 

Step 0. Add your site to Web CEO projects.

As soon as you add your site as a project in Web CEO, you can apply all Web CEO’s tools to it.

PART  I. Web CEO helps you find your 

niche keywords and optimize your pages

Decide which keywords and search terms 

are optimal for your site, and use these 

wisely on your Web pages.

Step 1. Research Your Keyword Niche

Spot popular and relevant keywords that 

people will use to find products and 

services like yours.

Step 2. Get Optimization Advice

Find out what changes are needed in your 

pages for high rankings with the keywords 

you selected during keyword research.

Step 3.  Edit Web Pages Easily 

Apply optimization advice you got at the 

previous step, without having to edit the 

HTML code.

PART III. Finally, you analyze your 

performance: rankings, links and visitor 

traffic

Measure your progress by getting reports 

on your rankings, inbound links, visitors, 

sales and conversion.

Step 7. Monitor Search Engine 

Rankings

Find out your rankings in search engines 

used by your targeted visitors to find 

information, products and services.

Step 8. Analyze Link Popularity

Find out how many sites – and which 

exactly – are linking to your site and 

competitors.

Step 9. Monitor Traffic With HitLens

View reports on your visitors, eCommerce 

revenues, and ad campaigns.

PART II. With Web CEO, you promote 

your site on the Web 

Let the people out there know about your 

site by submitting your optimized pages to 

the search engines and getting links from 

other websites.

Step 4. Submit Pages To Search 

Engines And Directories

Make sure your pages are automatically 

submitted to major search engines and 

directories across the world.

Step 5.  Find Link Exchange Partners

Find sites on the Web that could link back 

to you, manage your communication with 

them and monitor  your inbound and 

outbound inks.

Step 6. Manage Paid Search Campaigns

Easily create and manage advertising 

acconts on search engines that support 

paid listing, such as Google AdWords and 

Yahoo! Search Marketing (former 

Overture)

PART IV (additional). You can use Web 

CEO to keep your site in a good working 

condition

Use the supplementary tools available in 

Web CEO to ensure your site is trouble-

free and stays up around the clock

Step 10. Control The Quality Of Your 

Site

Find and fix broken links and other errors 

on your pages.

Step 11. Upload Your Site Using FTP

Upload pages, images, and other pages 

to your hosting server.

Step 12. Monitor Your Site Uptime 

Monitor availability and uptime of your site 

24 hours a day, non-stop.
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What should you do now? 
 

As you can see in the chart above, the initial step is to add your 
website(s) to projects. We then recommend that you slowly work 
through each remaining step to fully understand how powerful 
Web CEO is. 

 



 

 

Step 0. Add your site to Web CEO 
projects using Project Manager 

Please explain! 
 

Project Manager is a single control center from which you 
manage all your websites. Here you add new websites, delete 
those you no longer run, change project settings, etc. It is 
extremely convenient because once you add your site, you don’t 
need to type it in every time you perform a task – you will simply 
select it from the drop-down list. 
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How to add your website to Web CEO's projects 
 

 
Go to File > Project Manager. Press New site and then: 
 
1. Enter your website address, e.g. www.example.com. 
2. Enter a short description for the site, e.g., My site.  
3. Select or create a folder where you will keep this project, e.g. 

Office. 
4. Select the language of exported, emailed and printed reports 

of this project. 
5. Press Next. 
 
You are done. Now you can use all Web CEO’s tools for the 
benefit of your website. 
 
Note: Later you will need Project Manager to start tracking and 
analyzing your visitors and monitor the availability and uptime of 
your website. 
 
 

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 

Part I 
How do you find your niche and 
optimize your site? 



 

 

Step 1. Research keywords 

Why? 
 
To find the most popular, relevant keywords and phrases your 
target visitors enter when they search for information, products, or 
services you offer. 
 

Please explain! 
 

Before optimizing your Web pages for high rankings, you will need 
to define keywords and phrases. They will, on one hand, get you 
the maximum of visitors, but, on the other, they must be 
moderately competitive.   

For example, www.weatherscreen.com, which is featured as a 
DEMO project, distributes and sells a small software program that 
delivers daily and long-range weather forecasts to your PC 
desktop. Using Web CEO’s keyword suggestion tool (Features > 
Keywords) their webmaster did some keyword research and found 
out that the most popular keyword "weather" was requested 
83,100,000  times per month, but that there were 435,000,000 
pages whose webmasters would also want them at the top. 

Certainly a smaller website has a slim chance to outplay big 
players like The Weather Channel, CNN Weather or National 
Weather Service. This explains why at this stage the site owner 
only picked a few keywords out of the 1,000 that Web CEO 
suggested. All those keywords and phrases combine enough 
popularity, relevance and acceptable competition: for example 
"weather forecast" (monthly world searches – 6,110; competition 
according to Google – 37,000,000). 

Leaping ahead to Step 2 (optimization stage), she learned how to 
get her pages ranked highly with selected keywords. At Step 3, 
she applied the advice using Web CEO’s Editor, which is designed 
specifically for search engine optimization purposes. 

 

http://www.weatherscreen.com/
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How to find the right keywords 
 

Go to Features > Keywords and select your website in the 
Project Selector. Then enter the base keyword or phrase into the 
search box on the Get suggestions sub-tab (the 1. Find keywords 
tab) on the left-hand pane and press Get suggestions.  

In the left pane you will see related keywords and phrases 
normally used on related sites (this data is provided by Google). 
After you explore the subject niche, you can create your own 
keyword basket: 

 
1. Enter the keyword or phrase into the keyword field on the 

left-hand pane, e.g. weather forecast. 

2. Press Get suggestions.  

3. In the left pane you will see phrases that contain the base 
keyword as well as primary analysis of their popularity and 
number of competitors, e.g. weather forecast:  Google 
monthly searches – 2 379 000; competition – 691 000 000; 
KEI – 8,885. 

4. Select the results that catch your attention and press a 
blue arrow to add selected phrases to the Keyword basket 
in the right pane. 

5. Save the basket under an appropriate name, for example 
Weather-related searches. 
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Now you can go on the Analyze SEO competition and Analyze 
PPC competition tabs to further analyze keywords and phrases 
you have added to the Basket.  

 
Note: If you believe there is no further use in deeper analysis of 
the keyword selection, you may immediately go to Step 2: Getting 
optimization advice. 

 
What else can you do? 

 

 Go to the Spy on competitors sub-tab and see what keywords 
your competitors are using on their websites. 

 Go to the Suggestions from HitLens sub-report to see which 
keywords bring most traffic to your site and which keywords 
are useless.   

We recommend that you organize selected keywords into related 
groups and store them in different keyword baskets. You can print, 
save or e-mail the results of your work. It is useful when you need 
to share your work with your colleagues and customers or simply 
to change it into the form you prefer. For example, you can export 
data to Excel and analyze it there.  
 
 
 

What should you do now?  
 
After you have found the keywords and phrases which you will use 
to optimize your Web pages, please go to Step 2.  It will show 
exactly what page changes are needed to get high search engine 
rankings. 
 



 

 

Step 2. Get optimization advice 

Why? 
 
To learn what changes you should make in your pages so they 
appear among the top-10 listings. 
 

Please explain! 
 

Humans and search engines treat Web pages in different ways. 
Where people see design and copy, a search engine would detect 
the lack of quality information it needs to make your site relevant. 
The outcome of this could be that your website is ranked at a 
position where no one will find it. 

The optimization tool (Features > Optimization) lets you see your 
Web pages through the eyes of the major search engines (which 
produce 95% of the world search engine traffic) and to check how 
relevant they are.  

At the same time, Web CEO balances your site so it is neither 
under-optimized nor over-optimized. The former may get your site 
lost among hundreds of thousands of others while the latter would 
get your site penalized or worse – banned from the search engine.  

Note that Web CEO does this before you submit your Web pages 
to search engines. Therefore, search engines will consider pages 
optimized for their requirements, which multiplies your chances of 
being highly ranked the first time.  
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What are the results of this step? 
 

After analyzing your Web pages and optionally comparing them to 
your highly ranked competitors, Web CEO will create the following 
reports:  

 Optimization Advice and Analysis. Here you get plain-
English advice on improving your Web pages, plus the 
advanced analysis that contains detailed info on over 130 
parameters on your page that affect your rankings. Also, you 
can compare each parameter on your page to those of other 
Web pages that manage to get into the top-10 rankings.  

 Density Analysis Report. This report gives a breakdown on 
density of phrases used on your page. This helps you see 
what keywords and phrases your page is actually optimized 
for.   

 SE View Report. This report displays your page the way 
search engines actually view it – you can see the areas 
'visible' to this or that SE and understand where else you can 
apply optimization on your page. SE View Report also helps 
you prevent page cloaking (a spam technique of using 2 
variants of your page - one for the users, and another one – 
for the search engine bots).   
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How to get optimization advice for your website 
 
Go to Features > Optimization and select your website in the 
Project Selector. On the Setup tab, choose between the Local 
copy or Web page modes, press the Manage list… button and 
select the pages to be optimized. After the list of pages is set, 
enter the keywords for each page to be later used for analysis. 
Then: 

1. Go to the Optimization Advice and Analysis tab, and choose a 
Web page you want to analyze. This can be either a Web 
address or a local copy on your hard drive.  

2. Check the keywords/phrases you want to optimize the page 
for.  

3. Select a search engine to get optimization advice for. It can be 
a definite search engine*, e.g. Google as well as General 
Optimization. 

4. Optionally enter your competition’s Web address or check 
search positions for your keywords that you want to compare 
your page to. 

5. Press Start. 

 

 
 
Analysis will take between 30 seconds to 45 minutes, depending 
on the selected choices. After the analysis stage is complete, you 
will see a report with optimization advice and deep analysis.  
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What else can you do? 
 

 Go to the Density Analysis Report tab and have Web CEO 
analyze the density of the words and phrases frequently used 
on your pages. Those words might potentially be your targeted 
keywords.  

 Take advantage of the SE View Report to view your pages the 
way the search engines see them.  

 
 

What should you do now? 
 
After you have found out the strategies of your competition and 
have gotten advice on your pages optimization, it is important to 
make the necessary changes. Web CEO has the Editor (Features 
> Editor), which allows you to make the recommended changes 
easily. 



 

 

Step 3. Edit your pages for high search 
engine rankings 

Why? 
 
To apply recommendations obtained at the previous step and any 
other changes that, in your opinion, will improve rankings in search 
engines. 
 

Please explain! 
 

Probably you have a favorite HTML editor – Dreamweaver, 
FrontPage, or even Notepad. Whatever tool you use, it is 
undeniably great for creating Web pages from scratch, BUT it was 
not designed for the intricate work of optimizing your pages for 
search engines.  

Web CEO's Editor is not intended to replace your favorite web 
design program, but it is good for the light editing that search 
engine optimization usually needs. 

Please note that you don’t have to edit the HTML code directly 
because all the search engine critical areas of the page can be 
edited in visual mode. See below for a more detailed description of 
the editing process. 
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How to edit your pages for high rankings 
 
Go to Features > Editor and select your website in the Project 
Selector. Then: 

1. On the Setup tab, switch to the My site mode, then press 
Manage list… and browse for a folder on the disk where you 
keep the local copy of your pages and press OK. 

2. Web pages found in the specified folder will be shown in the 
list on the left.  Select the pages, one by one, and specify the 
keywords for which you will optimize each page. 

3. Check the pages you are going to edit.   

4. Now go to the functional tabs (Meta tags tab, Headings tab, 
ALTs tab, Links tab, Content tab, Optional Meta tags tab, and 
Find & Replace tab) and make necessary changes according 
to recommendations you received at Step 2. The purpose of 
each tab is explained on the next page. 
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What are the Meta tags tab and other tabs for? 
 
Using the tabs mentioned above, you can edit the most important 
areas of your page that search engines are concerned with. 

 Meta tags tab. This tab contains the following tags: Title, 
Description, Keywords, and 12 other less important Meta tags. 
To search engines, the Title tag is the most important tag on 
the entire page. Some regional search engines attach 
importance to the tags Description and Keywords.  

 Headings tab. It contains all headings tags found on your 
page – <h1>, <h2>, <h3>. These tags are also important to 
search engines. With Editor, you can easily change their 
content, i.e. add or remove keywords.  

 ALT tags tab. Every significant image must be backed up by a 
text description known as the ALT tag. Because these tags are 
important, by using Web CEO, you can view images on a page 
and add or change their alternative text descriptions. 

 Links tab. Any page will normally have a certain number of 
links pointing to other pages. Search engines analyze them to 
check if they contain your keyword. This tab shows a list of all 
text and image links on the selected page. You can edit the 
text that goes with them. 

 Content tab. This tab gives you access to the page content in 
two ways – visual and code so you can edit it in the way you 
prefer. 

 Optional Meta tags tab. This tab will help you handle the 
optional Meta tags such as Meta Author, Meta Copyright, Meta 
Language, etc.  

 Find & Replace tab. 
This tab is a real time-saver when you have to find and replace 
a word or phrase on multiple pages. For example, you can 
replace Copyright 2006 with Copyright 2007 on the pages - 
index.html, product.html, payment.html and privacy.html all in 
one go instead of having to do it manually. 
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What else can you do? 
 

 Change Title, Description or Keywords tags on multiple 
pages at one time. 
If you have selected several pages on the Meta tags tab, after 
changing the Title tag, Description or Keywords for one of 
them, you can apply changes to all the other pages.  

 Spy on your competition. 
At any time you can switch to the Competition analysis mode. 
Simply click Competition and see how your competitors place 
keywords in different areas of their pages.  

 Create Robots.txt file. 
To tell the search engine spiders what pages of your site they 
should or should not index, you can go to the Robots.txt tab 
and create the robots.txt file in a couple of clicks. 

 Create Sitemaps. 
Sitemaps are an easy way for you to inform search engines 
about pages available for crawling on your site. Robots usually 
discover pages from links within the site and from other sites. 
Sitemaps supplement this data to allow crawlers that support 
sitemaps to pick up all URLs in the sitemap and learn about 
those URLs using the associated metadata. To accomplish 
this, you can go to the Sitemaps tab and create the sitemap 
file in a couple of clicks. 

 
 

What should you do now? 
 
Now that your pages are ready to be indexed by search engines, 
you can upload them to your server (see Step 10) and go to Step 
4 where you will submit them to the most important search 
engines around the world, all handpicked by us. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 

Part II 
How do you promote your website? 
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Step 4. Submit your site to search 
engines and directories 

Why? 
 
To get registered with the best 200 search engines and directories 
on the planet that were either handpicked or requested by Web 
CEO’s users from more than 50 countries. The market share of 
these search engines is 94-96% of all traffic from search engines. 
 

Please explain! 
 
There are two contradicting myths. Myth #1 says that submitting 
your URLs to every search engine known to the human race will 
bring in free, highly targeted traffic to your site. Myth #2 is the 
opposite and says that submission doesn’t work at all.  

Surprisingly, both statements, to some extent, are true. The major 
search engines do find and index your site by themselves. 
However, if you submit your pages following their rules, you will 
get your site crawled more deeply. It means more of your Web 
pages will be visible to the public.  

Also, some minor, some regional search engines and all 
directories prefer that you submit your site and its pages instead of 
waiting for them to come to you. 
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How to register your URLs with search engines 
 
Below is the sequence of actions needed. On completing them, 
you will have your pages submitted to search engines and 
directories of your choice. 
 

 
 
Go to Features > Submission and select your website in the 
Project Selector. Then: 

1. Go to the Setup tab and enter all needed information search 
engines need for an acceptable submission.  

A. Enter there a webmaster or owner’s details, choose the 
category and subcategory for your website. 

B. Enter your site’s title, description, keywords, and specify 
the pages to be submitted (if you want to submit not only 
home page).  

 

 

 
2. Go to the top-level Auto submission tab. There are three sub-

tabs shown as A, B and C. Go through each of them. Don’t 
worry it is much easier than you think! 

A. Select SEs you want to submit your pages to. 

B. On the Submission tab, press Submit and watch the 
submission processed in real-time. When it has finished, you 
can save or e-mail the report with submission results.  

C. To see what search engines return in response to your 
submission request, go to the SE responses sub-tab where 
you will find reports explaining why a certain submission failed 
and what you need to do. 

3. Go to the Manual submission tab to get detailed 
recommendations on how to get registered with search 
engines that don’t accept automated submissions. Here, you 
will also find guidelines needed to qualify for inclusion within 
the major directories such as Yahoo! and DMOZ. See more 
information about manual submission on the next page. 
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4. After you have passed the submission process you can view 
the summary table for all submissions: auto, manual, 
successful or failed. Here two modes are available: Summary 
and Detailed. 

 

Why do you need to submit your site by hand? 
 
The leading directories such as Yahoo!, DMOZ, LookSmart, 
GoGuides, Joe Ant, and others require that you carefully choose a 
category where your website should be listed. It is important to 
give a proper description with your listing. Many directory users 
navigate through topical resources and use them for industry 
research. Therefore, a well-written description will bring in the 
most qualified traffic.  

Do not overload these sites with information, as all submissions 
(or ‘applications’ as directories call them) are approved by human 
editors for quality purposes. Naturally, it would become impossible 
to do if they received tons of automated submissions. 

 

How Web CEO helps you with manual submissions 
 
Web CEO divides hand submissions into seven main categories: 

 Directory Submissions. Directories have strict guidelines, 
and Web CEO helps your site with first time approval. See an 
example below. 

 Manual Submissions. If for some reason you do not want to 
use an automated submission tool, you can click on a link to 
the Add URL page in Web CEO and submit your URLs by 
hand and make a note in Web CEO of the date and time. 
Thus, your hand submissions will be displayed in the 
submissions report together with automated ones.  

 Paid Submissions. Some search engines will offer you extra 
benefits if you are ready to pay for them. These consist of 
express inclusion in their databases and regular re-spidering 
of your content.  

 Pay-Per-Click Submissions. Practically speaking, it is not 
submission but rather account registration with a search 
engine that will show your ad when a searcher enters your 
keywords in a search box. 

 Shopping Search Engines. If you have an online shopping 
business than you should certainly take advantage of both free 
and paid online promotion on the most important shopping 
search engines. 

 Press Release and News Sites. Have anything new or 
innovative? Inform Web surfers about it. Use online press-
release services that offer both free and paid distribution to 
search engines, newswires and websites. 

 Article Directories. Increase your site’s visibility – submit your 
articles to the Article directories to gain exposure to online and 
offline publishers. 
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 Blogs. Have a blog? Submit it to the most popular blog 
directories and blog search engines to bring more visitors and 
increase online visibility of your blog. Another option is to join 
blog communities to connect with other bloggers and attract 
more readers.  

 Sitemaps. Do you have pages with high priority status? Inform 
search engines about them. Use sitemaps to tell SE spiders 
which pages are newly updated and which pages are identified 
as the most important to help them better crawl your site. 

 

Besides, Web CEO allows you creating a custom list of your 
favorite resources. To add a new directory or a search engine, go 
to the Manual Submission tab, press Add Directory/SE, and 
follow the prompted steps of the wizard. 

 
How to submit your website by hand 

 
Here is an example of a manual 
submission to the well-known Yahoo! 
directory:  
 
1. Select Yahoo! (directory) from the 

Directories category. To the right, you will 
see detailed recommendations on how to 
get your site listed.  

2. After reading the guidelines, press Go to 
Submission Page. You will find yourself 
at www.yahoo.com. Carry out Web CEO’s 
recommendations, and submit your 
application for inclusion into the directory. 

3. Make a note of the date and time you 
submitted your site for consideration by 
editors. 

4. After getting the a SE’s response, press 
Make Status Record and assign the 
appropriate status. This submission will be 
included into the general submissions 
report. 

You are done. You can repeat this 
sequence with slight variations for other 
types of non-automatic submissions – 
Manual, Paid or Pay-Per-Click.  

 

 
 
 

What should you do now? 
 
After you have submitted your site, you may go to the next step 
and work on increasing your site visibility. The Partner Finder tool 
will help you search for link partners, manage correspondence 
with the site owners, and track your progress. 
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Step 5. Find link partners 

Why? 
 
To find good link partners and get high quality backward links to 
improve your link popularity.  
 

Please explain! 
 

Increasing your link popularity contributes to higher rankings, so 
having many links pointing to your site is good. However, not all 
links are considered equal.  

A back link from a high-ranked resource that is related to your 
website theme is much more beneficial to you than a link from a 
non-related resource that does not rank well or, worse still, a 
resource that is penalized by the search engines. That's why it is 
very important to build your link popularity wisely.  

You might wait for months to have someone link to you just 
because he/she has found your site interesting. However, there is 
a more effective way to increase your link popularity – searching 
for link partners with the help of Web CEO Partner Finder.  

This step will help you simplify the challenging and time-
consuming tasks: 

 Searching for link partners and evaluating each site on a 
dozen of parameters such as Google PageRank, Alexa Traffic 
Rank, DMOZ Listing, Meta Description, link popularity, etc. 

 Managing correspondence with each site owner and tracking 
the results of your correspondence. 

 Creating partnership agreements and checking the inbound 
links status. 
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How to get good link partners 
 

Go to Features > Partners and select your site in the Project 
Selector. You will then have to: 

A. Search for link partners 
B. Manage your correspondence with the site owners 
C. Set partnership agreements and monitor partner links 

A. Search for link partners 
 
In case you launch the Partner Finder tool for the first time, you 
will find yourself on the Search for partners tab and will see the 
short instructions on the screen.  
 
Press Configure to go to the profile settings. They will appear as 
in the screenshot below. (If you tried to set up a profile before 
reading this guide, select Edit profile from the Partner Finder 
Profile drop-down menu). 
 

 
 
1. On the first tab select search modes you want Web CEO to use 

when looking for potential partners, i.e. you can search for 
partners using your targeted keywords, looking for sites that 
link to your competitors or with the help of the two above 
mentioned modes. 

2. Go to the Select search engines tab and select the search 
engines your targeted visitors search with.  

3. Go to the Add keywords tab and import keywords from your 
site Meta keywords, text file, clipboard or another project or tool 
(Advanced import). Alternatively you can press Add 
keywords manually, and enter keywords related to the topic 
of your website. 

4. Go to the Add competition tab to add the URLs of your 
competition. 

5. Optionally, you can go to the Set scan rules tab. This controls 
the technical parameters for the scanning search engines 
results page and filtering the websites that might be your 
potential partners. By default, they are set to provide best 
performance; however, you may want to change them, for 
example, to increase the depth of scanning.  
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Now that you have set up the partner finder profile, press Find 
link partners and wait until Web CEO scans the search engines 
and builds a list of potential link partners. 

As soon as the report is ready, you can review the list of your 
potential link partners, evaluate each website and sort them by 
relevance: 

 

1. Evaluate each website taking into account its weight on the 
search engines (SE score parameter) and its relevance to your 
topic (Title, Meta Description, and Meta keywords). 

2. To get more details on each website (such as Google 
PageRank, Alexa Traffic Rank, link popularity, etc. ), highlight 
the site and click Site Info at the bottom right of the screen: 

3. To sort websites by relevance, check the site (or a group of 
sites) in the list, right-click the mouse and select one of the 
actions (Move checked sites to 'Personal correspondence', 
Move checked sites to 'Automatic correspondence', or Move 
checked to 'Partners'). You can also delete the unwanted sites 
from the list if you think they are not worth partnering with. 
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B. Manage your correspondence with the site owners 

 
After you have reviewed and sorted the websites, you can now go 
to the Manage correspondence tab to contact the relevant 
resources. 
 
Before you start sending emails, Web CEO will prompt you to 
enter the contact info necessary to email the site owners, create 
email templates, and configure settings for the automatic 
correspondence cycle. 
 

 
 

1. On the Email Settings tab, choose the mail account(s) to be 
used contacting your potential partners via automatic and 
personal correspondence.  

2. Create email templates on the Templates tab. By default, Web 
CEO offers three pre-made standard templates that can be 
customized using the Variables. Besides, you can use the 
Variables when creating your own templates as well. 

3. On the next tab, you assign email templates for each step of 
the automatic correspondence cycle and configure optional 
parameters. 

4. The Email Search Rules tab represents settings to be used 
when looking for email addresses of your potential partners.  
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On pressing OK, you will find yourself on the Personal 
Correspondence sub-tab. Sending emails to your partners is easy 
thanks to the user-friendly interface of the Partner Finder tool: 

 
1. Double-click a website in the list. The Send email manually 

dialog will pop up. 

2. Enter the email subject and the message itself into the 
corresponding fields.  
You can feel free to use templates when creating an email. 
Just click Insert template at the bottom left, and select the 
template you need. 

3. Press Find emails to have Web CEO search for the email 
addresses of the potential partner. This process might take a 
couple of minutes. 

After you are done, press Send. 

 

 
 
 
The things are handled even more simply on the Automatic 
correspondence sub-tab.  
 
Since you have previously configured all settings needed for the 
automatic correspondence cycle, you now only have to press the 
Send Bulk button and wait until Web CEO sends all pending 
emails. 
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C. Set partnership agreements and monitor partner links 

After you have corresponded with potential partners and they 
linked to your site or you have exchanged links, it is time to 
monitor your inbound links. And if you have, say, 100 inbound 
partner links, it is crucial to have an easy and quick way to check 
their status as it is impossible to check periodically your partners 
to see if your links have been removed or hidden by a black-hat 
technique. 
 
Before you start tracking your partner links, Web CEO will prompt 
you to enter necessary info to specify the partner sites and 
configure partnership agreements. 
 

 
 
1. Go to the Manage partner domains tab and select domains 

you'd like to create partnership agreements for.  
 
 

2. Go to the Configure partnership terms tab, select a partner 
domain and press Add agreement. You will be able to 
configure various settings to check the quality of the partner 
links, i.e. check if referring link is still on the partner's page, 
check if partner cloaks links to you from spiders, check if the 
quality of the referring page is satisfactory. 
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Now that you have set up the partners’ profile, press Review 
status and wait until Web CEO scans the partners’ websites and 
builds a report. 

As soon as the report is ready, you can review the list of your 
partnership agreements and their current status: 

 

 

 
1. Results are immediately displayed on the screen as each is 

processed, in real-time.  
 
2. To simplify analysis, use one of the predefined filters. For 

example, in the screenshot, the default All agreements filter is 
applied and shows all partner domains and all agreements 
assigned to them. If you have a large number of partners and 
agreements, you may want to select, say, the With "Problems" 
status filter from the drop-down menu to see partner 
agreements that do not meet the requirements specified in the 
settings. 

 
3. The Partners report is presented in two forms. Select one of 

the two views – Summary or Detailed report to get your 
preferred presentation. 

 
4. If you have already run the links check, use the Details button 

to view 'Sent e-mails history' / 'Site details' for partner 
domains.
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What else can you do? 

 

 Track history on emails sent automatically. 
Double-click a website in the automatic correspondence list to 
see the history on sent emails.  

 See results of your work with the Partner Finder tool. 
Go to the Summary tab to see results of your work. This tab 
represents info on your correspondence with the 
owners/webmasters of all revised websites, lists those 
websites that you consider your partners and the type of 
partnership agreements.  

 
 

What should you do now? 
 
You must have worked hard on optimizing your pages (on-the-
page factors influencing your rankings) as well as increasing your 
link popularity (off-the-page factors that might contribute to higher 
rankings).  
 
To bring more targeted visitors to your website, you might also 
want to take advantage of the paid search opportunity. PPC 
Campaigns Manager can help you manage your PPC campaigns 
with ease.  
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Step 6. Manage Paid Search Campaigns 

Why? 
 
To register new PPC accounts with both large and small PPC 
search engines and manage your existing PPC campaigns in a 
convenient and easy manner.  
 

Please explain! 
 

PPC (pay-per-click) is a short advertisement, which typically 
appears alongside the search engine results pages and leads 
visitors to your site. When running a PPC campaign, you pay 
whenever someone clicks on your ad. 

In order to get clicks from a PPC search engine, you are supposed 
to register a PPC account with the chosen SE, set keywords to bid 
for, and manage your PPC account on a regular basis.  

To run ad campaigns for several sets of keywords or several 
websites, you might need to register several PPC accounts. 
Besides, you might wish to investigate partnering with several 
PPC providers – major ones, which bring more traffic but feature 
higher bids, and smaller ones, which charge much less for a single 
click or impression.  

This might cause a mess when it comes to recalling numerous 
logins and passwords.  However, the things become easier to 
handle if you use Web CEO’s PPC Campaigns Manager.  
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How to create a new PPC account 
 

Go to Features > PPC Campaigns. Then: 

 
1. Press the SE List Manager button and select the PPC search 

engines you will work with. The selected SEs will then appear 
in the Search Engines list on the left-hand navigation pane. 

2. Click on the search engine in the left pane; you will see the 
info page in the right-hand window. 

3. After you read general info on the chosen SE and make up 
your mind to create a PPC account with it, select the Go to 
page option at the bottom of the page, choose Sign Up, and 
press GO.  
You will be taken to the Sign Up page of the given SE. Please 
follow all prompted steps to create your PPC account with this 
search engine. 

 

 

 

After you sign up, an automatic email with your PPC account 
details will be sent to your registration email.  

To add the account dataset to the PPC Campaigns Manager, right-
click on the search engine name in the list, select the Add a 
dataset option and press GO. Fill in the required fields; the newly 
created dataset will appear in your custom list of the PPC search 
engines.  
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What else can you do? 

 

 Log in to your PPC account without re-entering a login 
and password. 
Click on the previously created PPC account name in the 
'Search Engines' list on the left-hand navigation pane and 
press the Log in button. 
You will be directed to the login page of the chosen search 
engine. Your login and password will be automatically filled in 
into the login section. 

 Change the dataset details. 
To change any details of the account dataset (account name, 
login or password), right-click the account name in the list and 
select Edit account dataset.  
Note that the changes will be applied only to the account 
details stored in the PPC Campaigns Manager! 

 
 

What should you do now? 
 
Once you have settled down your promotion activities, it's time to 
see your traffic grow and measure your achievements in terms of 
acquired rankings, inbound links, visitors, and conversion rates. 
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Part III 
Analyze your performance 
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Step 7. Check your rankings in search 
engines 

Why? 
 
To find out the current positions of your site with keywords in 
search engine results pages so that you can see the effect of your 
optimizations and check your site's progress over time. 
 

Please explain! 
 

Obviously, you have spent much time researching keywords, 
applying optimization advice, submitting your website, and taking 
other measures the previous steps required, so are your efforts 
effective?  

Checking your rankings is the first and fastest way to answer this 
question. You can either do it by hand or use Web CEO. The latter 
will save you great amounts of time that would otherwise be 
wasted on hand querying and position tracking with Excel or other 
tools. 

Pretending to be human, Web CEO examines search engine 
results pages and builds a real-time report giving the exact 
positions of your website with targeted keywords. It includes 
several search engine results pages, which show where your site 
was found. 

All in all, you will get the same results as if you tracked your 
rankings manually, but they are far more understandable. Web 
CEO has many preset views, which allow you to quickly see 
specific reports, e.g. pages that are in the top-10 or top-20. 
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How to check your positions in search engines 
 

Go to Features > Ranking and choose your website in the Project 
Selector. To find out your rankings you need to do two things:  

A. Set up a ranking profile 
B. Learn how to use the ranking report 

A. Setting up a ranking profile 
 
When you run the ranking checker for the first time, simply read 
the brief instructions on the screen and press Start to be taken to 
the profile setup. (If you tried to set it up before, select Edit profile 
from the drop-down menu Ranking profile). See a detailed 
explanation under the screenshot below. 
 

 

 
 
1. Go to the Select search engines tab and check the search 

engines your targeted visitors search with. For guidance, use 
the additional information available about each search engine – 
Country, Language and Popularity. 

2. Go to the Add keywords tab and import keywords from your 
site Meta keywords, text file, clipboard or another project or tool 
(Advanced import). Alternatively you can press Add 
keywords manually, and enter the keywords you want to use 
to check your rankings. 

3. Go to the Set scan rules tab. This controls the technical 
parameters for the scanning search engines results page. By 
default, they are set to provide best performance; however, you 
may want to change them, for example, to increase the depth 
of scanning.  

4. Go to the Include extra data tab. Here you can set Web CEO to 
show Google monthly searches and traffic report for the last 30 
days. 

Now that you have set up the ranking profile, press OK, and you 
will be taken to the program’s main screen where Web CEO will 
show your rankings in an extensive report with expanded position 
analysis. 
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B. How to use the ranking report 
 
Looking at the screenshot below, you can see that Web CEO 
outputs result in a very simple form, but first, let's learn how this 
tool works: 

 

 

 

1. Press Start. Instantly, Web CEO starts requesting the search 
engines you selected (Google, Windows Live and Yahoo! in 
the screenshot) for the keywords you entered during the profile 
setup ("long-range weather forecast", "horoscope signs", etc.).  

2. Results are immediately displayed on the screen as each is 
processed, in real-time. For example: 

On February 19, 2010 index.html was ranked 3 on Google for the 
keyword "weather forecast software". It has moved since the 
previous check. You can disable this option or compare the 
current result with the best one or previous scan by selecting the 
options None, Previous or Best. 

3. To simplify analysis, use one of the 12 predefined filters or 
create new ones based on your criteria. For example, in the 
screenshot, the In top-10 filter is applied; therefore, it only 
shows keywords that are in the top 10 search results for your 
keywords. To see the full report, select the All Results filter 
from the drop-down menu. 
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Will you have problems with search engines because of 
automated queries? 

 

Admittedly, search engines dislike automated queries to their 
databases. But, in reality, webmasters can't live without it. 
Otherwise, they would have to manually check rankings and 
spend far too much time than is practical.  

Web CEO includes technology to stop your IP from being included 
in the blacklist, and it offers the best protection in the industry. 
Because it professionally emulates a browser and, at the same, 
time pretends to be human, search engines treat your queries as 
ordinary, non-automated ones!  

All related settings can be found in File > Settings > SE 
Requests. 

 

What else can you do? 
 

 Check rankings of your competitors and compare the 
results to yours. 
Go to the Competitors’ Rankings tab and configure the ranking 
profile. You will be able to add URLs of your competitors to the 
profile settings in order to get a comparative report on your 
rankings vs. those of your competitors.  

 Learn what pages of your site have been indexed by the 
major search engines. 
Go to the Indexed Pages tab, check the search engines you 
target, and press Start. You will get a list of all your pages 
indexed by the chosen SEs. 
On the Competitors Indexation tab, you can check how many 
pages of your competition have been indexed by the selected 
SEs. 

 Check your ranking score. 
To track your site's performance on a multitude of search 
engines, you can take advantage of the Ranking Score 
Report. You will be able to track changes in both your ranking 
score, as well as those of your competitors, over time.  

 View snippets displayed on the SE result pages. 
Each search result usually includes one or more short 
selections of the text that match user's query with search 
terms in boldface type. This report shows what snippets Web 
surfers see when they enter one of your search keywords in 
the search field.  

 

What should you do now? 
 
After you have checked your rankings on the major search 
engines it is time to analyze your site visibility on the Web. The 
Link Popularity tool will tell you how many pages link to your site 
and who exactly links to your pages according to the most popular 
search engines. 
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Step 8. Analyze your link popularity 

Why? 
 
To discover how many links to your site are found by search 
engines and exactly who links to your site, learn about your 
competitors' link popularity, and analyze keyword theme of your 
links' text. 
 

Please explain! 
 

When someone enters your keyword in a search box and presses 
the Search button, the search engine starts checking how closely 
your site relates to the query. Now, link popularity comes into play.  

Modern search engines (especially Google and Yahoo!) not only 
analyze the content of your pages, but also look closely at who is 
linking to your pages and how. The point is that they treat each 
link to your site as a recommendation. When they have to decide 
how highly to rank your page in their listings, they use this 
information as an important part of their algorithms. 

This explains why so many poorly optimized Web pages are 
ranked more highly than your well-optimized ones. Their 
webmasters took care to ensure that other websites link to them 
using their keywords. For example, Weather.com is certain to be 
in the top-10 with the keyword weather since tens of thousands of 
webmasters put a link to it using this keyword.  

This step will provide the following information: 

 A detailed report on the number of Web pages that link to your 
site and its pages.  

 The number of sites linked to your competition so you can 
estimate how difficult it would be to outplay them. 

 Which Web pages link to your competition. 

 What words and phrases are used as anchor text when other 
sites link to your one. 

 What sites link to most of your competitors and/or to your site. 
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How to discover your link popularity 
 

Go to Features > Links and select your site in the Project 
Selector. You will then have to: 

A. Set up a link popularity profile 
B. Get report on your link popularity 

A. Set up a link popularity profile 
 
When you launch this tool for the first time, please read the short 
instructions on the screen and press Start to go to the profile 
settings. They will appear as in the screenshot below. (If you tried 
to set up a profile before reading this guide, select Edit profile from 
the Links profile drop-down menu). 
 

 
 
1. On the Select search engines tab check the search engines 

where you want to check link popularity, e.g. Google, Blekko 
and Majestic SEO. 

2. Go to the Add pages tab and import keywords from your site, 
text file, clipboard or another project or tool (Advanced 
import). Alternatively you can press Add pages manually, 
and enter the Web pages to be analyzed. 

You are done. Press OK to return to the main screen with the link 
popularity report. On the next page, you will learn how to use it. 



Step 8. Analyze your link popularity  44 

B. Get report on your link popularity 
 
As you can see by looking at the screenshot below, Web CEO 
displays results of its work in a very simple way. Now you will learn 
how to get this information for your site: 

1. Press Start. Web CEO will start getting the link popularity of 
your pages from search engines you selected. All data will be 
shown in the report in real time as the program processes it. 

2. During or after the checking process, you can analyze the 
results. For example: 

Link popularity of www.weatherscreen.com/index.html in Yahoo! 
is 948. It means Yahoo! has found 59 new links since the last 
check. The link popularity in Google has encreased. 

3. For a more thorough analysis, double-click a Web page or 
select a report from History. 
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What else can you do? 
 

 Check your competitors' link popularity. 
To evaluate the link popularity of your competitors' websites, 
go to the Competition tab, check the SEs, and add your 
competitors' URLs to the list. Feel free to enter your site URL 
as well so that you can compare your performance to that of 
your competitors. 

 Learn what websites link to yours. 
To find out which pages link to you, go to the Linking pages 
tab.  

 Pinpoint the keyword theme of your links. 
To get a deep analysis of your links text, take advantage of the 
Link text analysis report.  

 Get an overview of the sites that link to you and your 
competition. 
Run the Linking sites overview report to get a list of all sites 
that link either to you, to one of your competitors, or to several 
of them.  

 
 

What should you do now? 
 
You have discovered your link popularity and found out how you 
stand out against competitors and top-ranked sites. The next step 
of your site promotion strategy is monitoring your visitor traffic with 
HitLens. You will use it to understand your visitors and analyze 
eCommerce revenues and Ad campaigns. Read how to start 
tracking your visitors in the next section. 
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Step 9. Analyze your visitors, revenue, ad 
campaigns, and more 

Why? 
 
To learn as much as you can about your visitors and the revenues 
your site makes and find out which ad campaigns work best for 
you.* 
 

Please explain! 
 

All successful websites have at least one thing in common – their 
webmasters and owners use Web analytics to increase the 
percentage of visitors who do something GOOD for business.  

Analyzing visitors, revenue sources, and advertising efficiency 
combined with constant improvement of your site inevitably boosts 
revenues. HitLens, Web CEO's traffic analysis tool, helps you: 

 Understand your visitors. It’s easy! Because you will be 
armed with over 80 reports organized into 8 categories. 

 Evaluate the commercial efficiency of your site. Reports in 
the eCommerce* category give you a full and detailed account 
of your revenues. They tell you how good your site is at 
converting the accidental browser into an impulse buyer! 

 Find out if you are wasting money. Reports in the 
Campaigns* category measure the effectiveness of your 
advertising and uncover sources of traffic that you should 
explore and perhaps invest in, e.g., AdWords or a 300x250 
banner on www.example.com, etc.  

_____________________________________________________ 
* Ecommerce reports are available in the eCommerce Reporting Plan of 
HitLens service. 
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How it works 
 

Whenever someone comes to your site, a Web server records his 
activity as he is surfing your site. Later, this information can be 
extracted from the so-called log files and analyzed. This approach 
has many flaws such as delays in reporting and low accuracy. 

HitLens does things differently; it tracks visitors and transactions in 
real time. It does not distort the statistics.  A snippet of its tracking 
code is embedded in your pages. This records all information 
available on the visitor. This is immediately passed to our 
Datacenters where it is finally converted into analytical reports that 
you can view with Web CEO. 
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How to do visitor tracking for your website 
 

Run Project Manager (File > Project Manager), select your site 
and press HitLens Activation. Web CEO will launch HitLens 
Configuration Wizard. Then take these 3 easy steps: 
 
 
 

 
 

 

If you need detailed instructions, please visit 
http://www.webceo.com/support/hitlens.htm where  

this procedure is explained in detail. 
 

http://www.webceo.com/support/hitlens.htm
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How to view analytical visitor reports 
 
Go to Features > HitLens. At the top of the screen, you will see a 
Categories panel with 10 different categories of reports. The 
default category is Favorites. On the left, you will see reports the 
selected category contains.  

To learn what reports and categories to use, take a look at the list 
below. Note that it only lists the most commonly used reports out 
of 120 currently available. 

A. Analyze your visitors 

Web CEO helps you get to know your visitors. See the reports 
below to find out how they browse your site, what they like, and 
what makes them leave without wanting to come back! 

Category: Traffic 
 Brief Traffic Analysis 

 Traffic Summary 

 Unique Visitors 

 Page Views 

 Repeated Visits 

 Total Downloads 

 Downloads by Period 

 Downloads by File 

Category: Visitors 
 Unique Visitors  

 New Visitors 

 Visitors' Details 

 Frequent Visitors 

 Motivated Visits 

 New Visitors' Second Visits 

 Visit Frequency 

Category: Navigation 
 Navigation Paths 

 Entry Pages 

 Exit Pages 

 Single Pages 

 Site Stickiness  

Category: Referrers 
 All Referrers 

 Referring sites and pages 

 Search engines 

 Search keywords 
 
When you have the full picture, you can adjust your site to match 
your visitors’ needs. They will be more interactive with your site. 
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B. Analyze eCommerce revenues 
 

Like any business, the better you understand your customers, the 
more sales and leads you will create.  

The information you get in the eCommerce category of reports 
helps you put emphasis on what is most important. The reports 
show how well each traffic source performs in terms of revenue, 
registrations, subscriptions, etc. You get full details on each 
transaction and see an audit of how a visitor becomes a buyer: 

eCommerce summary 
 Revenue 

 Transactions 

 Average Order Size 

 Revenue per Visit 

Activity overview 
 Activity by Search Engines 

 Activity by Search Keywords 

 Activity by Referring Sites 

 Activity by Countries 
 

C. Analyze ad campaigns 

If you have a marketing budget to promote your site and you use 
any type of online media (paid search, banners, text links, etc.), 
you should track and analyze your ad campaigns.  

The Campaigns category reports enable you to find out which 
resources are worth investing in and which are not. You will get a 
full and detailed account of the campaigns that you are running. 
They include visits and actions for each campaign generated, e.g. 
Google AdWords ($2000 budget) produced 5,832 visits, 126 
orders totaling $9254 in revenues, plus 537 newsletter subscribers 
and 417 catalog requests: 

 Activity by campaign 

 Cost of visit by campaign 

 Cost of action by campaign 

 ROI 
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Part IV 
How do you maintain your 
website?  
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Step 10. Upload your website using FTP 

Why? 
 
To quickly and easily upload your Web pages, images, and other 
files to your server or host. 
 

Please explain! 
 

When you actively improve your site, it undergoes many changes: 
you fix broken links, add new pages, and refresh content. You just 
want to simply upload your changes with the minimum of hassle.  

Web CEO has a simple and easy-to-follow tool to deliver files from 
your PC to the server (and vice versa) over FTP (File Transfer 
Protocol). It enables you to copy, remove, and rename folders on 
the server as you do on your own PC. 
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How to upload your Web pages and files 
 
Go to Features > Uploader. Then:  
 
A. Set up connection settings  
B. Upload your files 

 
 
A. Set up connection settings 
 
Select your website from the Project drop-down menu and press 
Options. Then: 
 
1. Specify connection settings: 

A. Enter a host name to connect to. Normally, it is your site's 
address, but if you are not sure, you should contact your 
admin or hosting company. 

B. Enter the Username  

C. Finally, enter the Password. 

2. If needed, alter the advanced settings, but please note that 
they are set to a default of maximum compatibility with most 
servers. 

3. Press OK to save the settings and return to the main screen 
where you will be able to upload your files. 
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B. Upload your files 
 

After you have set up FTP connection, press Connect. Web CEO 
will connect to your server, and you will see the net folders and 
files on the right: 

1. Select the folder where you keep the local copy of the website 
that you want to upload, e.g. C:\www.weatherscreen.com. Its 
contents will be shown as a list in the left pane. 

2. Select the Web pages and files to be uploaded. Hold Ctrl 
when selecting, to choose individual files. 

3. Press the blue arrow button to start copying files from your PC 
to the server. 

 

 
 
If you want to download files from a server to your PC, switch to 
the right pane, select the files and press the blue arrow button, 
which will change its direction to the left. 
 
 
 

What should you do now? 
 

The site cannot have annoying errors like broken links, slow 
pages, etc. It must be usable, accessible, and available for your 
visitors twenty-four hours a day. The following two steps explain 
how to achieve these essential goals with Web CEO.
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Step 11. Control the quality of your site 

Why? 
 
To find all the errors and problems on your website pages and fix 
them. 
 

Please explain! 
 
It is not enough to get visitors to come to your site. You must also 
make sure they don't leave it straight away because of 
annoyances such as: 
 

 Broken links 

 Missing images 

 Untitled pages 

 Slow pages 
 
These faults are bad for your reputation. Studies have shown that 
nearly a third of people will not return because of usability issues. 
Naturally, you must find and fix these revenue burning problems, 
and Web CEO is very adept at it.  
 
FACT: Web CEO detects serious errors on 89% of sites and minor 
errors on 99% of sites. 
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How to pinpoint problems on your website 
 
Go to Features > Auditor and select your website in the Project 
Selector.  

1. By default, Web CEO scans your site on the Web. However, 
you can have the local copy of your site examined. Check the 
Local scanning option and specify a path to the home page on 
your hard drive. 

2. Press Start and wait while Auditor examines each page of 
your site.  

3. When the check is over, you will see a list of Web pages with 
small signs next to each problem page. If you see a red cross, 
a potential problem has been found on the page, and if you 
see an exclamation mark, the page is in trouble because a 
serious error has been detected. 

4. If you select a Web page in the left pane, on the right, you will 
see the (a) Properties and (b) Errors and Warnings found on 
that page. At a glance, you will know what is wrong with that 
page and what you should do. 

 

 
 
_____________________________________________________ 
Note: If you are a webmaster, you can immediately fix errors found and 
upload your site to the Web with the FTP Upload Tool (Features > 
Uploader). See Step 10. Upload your website using FTP. 
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View the report on site usability and accessibility 
 
If you switch to the Site tab from the Report tab, you will see the 
list of reports Auditor created after checking your site. You will 
need these reports if you are not the webmaster for the site tested.  

For example, if you analyze a site’s usability and quality for a 
customer, you can share the reports Web CEO generates with the 
site owner and webmaster (see Site quality overview for CEO and 
Site quality overview for Webmaster respectively): 

 

1. Reports for Customer. Here, 
you will find reports designed for 
sharing with your customers. 

2. Summary. General information 
on your site: types of files, 
parameters of scanning, etc. 

3. Errors. Critical reports that highlight 
problem spots on your site. These 
damage your reputation and 
decrease visitors' satisfaction. For 
example, see the Problem pages 
report, which lists all Web pages 
having at least one problem (the 
worst of them are broken internal and 
external links and anchors). 

4. Usability. Many factors have an 
impact on a site’s usability. The top 
causes being Deep and Slow pages. 

5. Maintenance. The reports in this 
category will bring your workload 
down. You can easily find out which 
pages are missing Titles and Meta 
tags as well as which of them were 
refreshed recently or are out-of-date. 
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Tuning up Auditor 
 
You can set Auditor to fully serve your site’s needs. To do that, 
press the Options button in the bottom-right corner and change 
the settings so they suit your requirements. Note that these 
settings will be valid for the current project only. 

To change the global settings for Auditor to be applied to all sites, 
go to File > Settings > Auditor. 

 
 
 

What should you do now?  
 
After you have locally fixed the errors found, you will need to 
upload Web pages to your server. 
As soon as the code is fixed and the Web pages are updated, you 
can check if the site is always available to your users. Web CEO’s 
monitoring service will help you accomplish this task. 
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Step 12. Monitor your site uptime 

Why? 
 
To get alerts by e-mail, pager or cell phone whenever your site is 
down or doesn't function properly.* 
 

Please explain! 
 

Can you say with certainty that your site is available to visitors 
right now? Will it be functioning properly in fifteen minutes or 
tomorrow at 3:07 AM? Will it be hit by a new virus or a hacker 
attack? The monitoring service built into Web CEO will make sure 
that things continue to work as well as they can. 

A special robot visits your website every 5-120 minutes 
(depending on the service plan you choose) from different parts of 
the world and checks if your site is up and its services (E-mail, 
FTP, HTTPS) are functioning. The moment it detects a problem, 
you, and the other people in charge of your website, will get 
warnings by e-mail, pager, or cell phone with the problem 
description and status. 

At any time, you can see real-time reports on the performance of 
your server: Connect time, Host ping, Download time, DNS 
resolve time, Download speed, Time-outs, Time on error and 
Uptime.  
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How to monitor your website 
 

To get started with site monitoring, you need to do the following: 

A. Choose a monitoring plan 
B. Set up the monitoring parameters 
C. Create alert notifications 
D. View real-time reports 

A. Choose a monitoring plan 
 
Run Project Manager (File > Project Manager) and select a site 
to be monitored, and press Monitoring plan. You will then see the 
following screen: 
 

 
 

 
1. Select the monitoring plan of your choice: Free, Silver, Gold or 

Platinum. 
The main difference between the monitoring plans lies in the 
monitoring interval (5 min, 15 min, 30 min, or 480 min). Also, 
premium features such as advanced and intercontinental 
monitoring are only available in the paid subscription plans. 

2. Press OK and confirm changes. 
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B. Set up parameters of monitoring  
 
Go to Features > Monitoring and select your website in the 
Project Selector. Then:  

1. Press Highlight services available for monitoring. Web 
CEO will test your server or host to detect which parameters 
can be watched by the Datacenter. Available options are 
highlighted as shown in the screenshot below. 

2. In the Basic monitoring section, you can check the HTTP 
option and the Host ping option. This tells you if visitors can 
connect to your server or hosting company and see your Web 
pages.  

3. You probably want to check some of the advanced options:  
 
A. The incoming mail server availability (POP3). 
B. The outgoing mail server availability (SMTP). 
C. The content monitoring option warns you when text (a word 
or phrase) is missing on your site. 
D. The additional ports monitoring option enables watching 
services such as SSH, HTTPS, or specific port numbers. 

4. After you have set up the monitoring parameters, press Apply 
and go on to create the alert announcements that all those 
responsible for your website will get when an error occurs. 
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С. Create alert notifications 
 

 
 
 

1. Press New and enter Name and E-mail to be contacted, check 
the situations to be alerted of, and enter the text of warning. 

2. To change an existing contact, select it and press Edit, and 
make necessary changes, e.g. change text of the message 
sent when your site is down or the e-mail address of the 
recipient. 

D. View real-time reports  
 
After you have created the alert announcements, go to the Status 
and Reports tabs to view real-time reports of your site's 
performance and availability to visitors.  
 
The Status tab offers you a text-based report that outlines how a 
certain service performed over time. The Reports tab delivers 
mixed, both text and graphical reports, giving you an idea how 
your site performs over time 
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  A final note from the Web CEO team 

Dear Reader, 
 
We hope that you have now learned most of what Web CEO can 
do. 
 
It has taken us years of research and hard work to produce such a 
powerful program. If you have slogged through this guide from 
cover to cover, we hope you agree, and if you have not tried it yet 
– what are you waiting for?  
 
;-) 
 
Kind Regards, 
The Web CEO Team 

 

 

 


